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Tools
Selection  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  V
Direct Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  A
Group Selection .  .  .  .  . Use on graphs & nested groups
Magic Wand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Y
Lasso .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Q
Pen .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . P
Convert Anchor Point .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+C
Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . T
Line Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . \
Rectangle .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . M
Ellipse .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . L
Paintbrush .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  B
Pencil  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  N
Rotate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  R
Reflect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  O
Scale .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . S
Warp .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+R
Free Transform . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . E
Symbol Sprayer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+S
Column Graph .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . J
Mesh .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  U
Gradient .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  G
Eyedropper . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  I
Blend  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . W
Live Paint Bucket .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . K
Live Paint Selection . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+L
Crop Area .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+O
Slice . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+K
Eraser .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+E
Scissors .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . C
Hand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  H

Page
Zoom . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Z
Toggle Fill/Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . X
Default .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  D
Swap Fill/Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+X
Color .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  ,
Gradient .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
None .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . /
Toggle Screen Mode .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F
Show/Hide All Palettes . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Tab
Show/Hide All But Toolbox . . . . . . . . . . . . . Shift+Tab
Increase Diameter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . ]
Decrease Diameter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . [
Symbolism Tools - Increase Intensity .  .  .  .  .  .  .  Shift+}
Symbolism Tools - Decrease Intensity . .  .  .  .  .  .  Shift+{

Illustrator menu
Preferences  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+K
Hide Others  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+H
Quit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+Q

File
New . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+N
New from Template . .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+N
Open .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+O
Browse .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+O
Close .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+W
Save  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+S
Save As .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+S
Save a Copy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+S
Save for Web & Devices  .  .  .  .  .  .  .  Opt+Shift+Cmd+S
Place .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Export .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Other Script .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F12
Document Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+P
Document Color Mode .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
File Info . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+I
Print  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+P

Edit
Undo .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+Z
Redo .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+Z
Cut . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+X
Copy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+C
Paste .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+V
Paste in Front .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F
Paste in Back .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+B
Clear .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Find and Replace .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Find Next .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Check Spelling .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+I
Define Pattern .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Edit Colors  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Color Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+K
Keyboard Shortcuts . .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+K
Preferences > General .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+K

Object
Transform Again .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+D
Move .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+M
Rotate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Reflect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Scale .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Shear . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Transform Each .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+D
Reset Bounding Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Bring to Front . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+]
Bring Forward .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+]
Send Backward .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+[
Send to Back  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+[
Send to Current Layer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Group .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+G
Ungroup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+G
Lock > Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+2
Lock > Other Layers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Unlock All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+2
Hide > Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+3
Show All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+3
Expand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Expand Appearance  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Path > Join  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+J
Path > Average .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+J
Outline Stroke .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Offset Path .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Simplify  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Add Anchor Points . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Remove Anchor Points .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Divide Objects Below .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Split Into Grid . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Clean Up .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Blend > Make  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+B
Blend > Release  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+B
Blend > Reverse Front to Back  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Envelope Distort > 
Make with Warp  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+W
Make with Mesh .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+M
Make with Top Object  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+C
Envelope Distort > Release .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Edit Contents  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+V
Live Paint > Make  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+X
Text Wrap > Make . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Text Wrap > Release . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Text Wrap Options > Offset .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Clipping Mask > Make .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+7
Clipping Mask > Release .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+7
Edit Contents .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Compound Path > Make .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+8
Compound Path > Release  .  .  .  .  Opt+Shift+Cmd+8
Crop Area > Make .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Crop Area > Release .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Type
Glyphs . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Area Type Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Type on a Path Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Create Outlines  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+O
Find Font  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Change Case > UPPERCASE .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Change Case > lowercase  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Change Case > Title Case .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Change Case > Sentence case .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Smart Punctuation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Show Hidden Characters  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+I
Update All Legacy Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Select
All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+A
Deselect .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+A
Reselect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+6
Inverse .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Next Object Above  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+]
Next Object Below  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+[

Filter
Apply Last Filter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+E
Last Filter  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+E

Effect
Apply Last Effect  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+E
Last Effect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+E

View
Preview . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+Y
Overprint Preview .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+Y
Pixel Preview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+Y
Zoom In  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+=
Zoom Out .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+-
Fit in Window . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+0
Actual Size .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+1
Hide Edges .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+H
Hide Artboard .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Hide Page Tiling . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Show Template .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+W
Show Rulers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+R
Hide Bounding Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+B
Show Transparency Grid  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+D
Show Text Threads . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+Y
Show Live Paint Gaps .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Hide Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+;
Lock Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+;
Make Guides  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+5
Release Guides . . . . . . . . . . . . . . . . . . . . .Opt+Cmd+5
Clear Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Smart Guides  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+U
Show Grid . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+’
Snap to Grid .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+’
Snap to Point .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+’
New View .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Other Panel
New Symbol  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F8
Add New Fill  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+/
Add New Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+/
New Layer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+L
New Layer with Dialog  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+L
Switch Units . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+U
New File (No Dialog) . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Alt+Cmd+N
Close All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Alt+Cmd+W
Cut (Secondary) . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F2
Copy (Secondary)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F3
Paste (Secondary) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F4
Debug Panel . . . . . . . . . . . . . . . Alt+Shift+Cmd+F12

Adobe Illustrator CS3 Shortcuts
Window
New Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Save Workspace . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Minimize Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+M
Bring All to Front .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Actions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Align  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+F7
Appearance  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+F6
Attributes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F11
Brushes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F5
Color  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F6
Color Guide . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+F3
Control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Document Info . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Flattener Preview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Gradient  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F9
Graphic Styles  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+F5
Info .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F8
Layers  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F7
Links .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Magic Wand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Pathfinder  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+F9
Stroke  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F10
Swatches  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Symbols  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+F11
Transform  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+F8
Transparency  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+F10
Character .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+T
Character Styles . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Glyphs . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
OpenType .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+T
Paragraph . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+T
Paragraph Styles .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Tabs . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+T

Help
Illustrator Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F1
Welcome Screen .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Other Select
Switch Selection Tools  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+Tab

Other Text
Insert Hyphen .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+-
Point Size Up .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+.
Point Size Down . . . . . . . . . . . . . . . . . . . Shift+Cmd+,
Font Size Step Up . . . . . . . . . . . . . Opt+Shift+Cmd+.
Font Size Step Down .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+,
Kern Looser  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+]
Kern Tighter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+[
Tracking .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+K
Clear Tracking . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+Q
Spacing . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+O
Uniform Type .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+X
Highlight Font .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+F
Highlight Font (Secondary) .  .  .  . Opt+Shift+Cmd+M
Left Align Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+L
Center Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+C
Right Align Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+R
Justify Text Left .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+J
Justify All Lines .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+F
Toggle Auto Hyphenation  .  .  .  .  . Opt+Shift+Cmd+H
Toggle Line Composer  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+C

Other Object
Lock Others  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+2
Hide Others  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+3
Repeat Pathfinder .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+4
Average & Join . .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+J
Isolate Selected Group .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
Exit Isolated Group .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Mac
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